Congestion Control
WCDMA RAN

Feature Guide

Congestion Control Feature Guide

Congestion Control Feature Guide
Version

V4.0

Date

2010-6-23

Author

Shu Ruijun

Approved By

Remarks

Zheng Dan

© 2010 ZTE Corporation. All rights reserved.
ZTE CONFIDENTIAL: This document contains proprietary information of ZTE and is not to be disclosed or
used without the prior written permission of ZTE.
Due to update and improvement of ZTE products and technologies, information of the document is
subjected to change without notice.

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

I

Congestion Control Feature Guide

TABLE OF CONTENTS
1

Function Attributes..............................................................................................1

2
2.1
2.1.1
2.1.2
2.1.3
2.1.4
2.1.5

Overview.............................................................................................................1
Function Introduction .............................................................................................1
Congestion Control for R99 ....................................................................................2
Emergency Call ....................................................................................................2
Directed Retry to GSM ..........................................................................................2
Congestion Control Strategy for HSDPA..................................................................3
Congestion Control Strategy for HSUPA..................................................................3

3
3.1
3.1.1
3.1.2
3.1.3
3.1.4
3.2
3.2.1

R99 Congestion Control Algorithm ......................................................................3
Resource Preemption Policies ...............................................................................4
DCH Forced Release.............................................................................................6
DCH Downgrade ................................................................................................. 10
Congestion Scheduling ........................................................................................ 14
Preemption of Resources at lur Interface ............................................................... 15
Related Measurement ......................................................................................... 16
Node B Common Measurement............................................................................ 16

4
4.1
4.1.1
4.1.2
4.1.3
4.1.4
4.1.5
4.1.6
4.2
4.2.1

HSDPA Congestion Control Algorithm............................................................... 16
Resource Preemption Policies ............................................................................. 16
Forced Release .................................................................................................. 18
DCH Downgrade ................................................................................................. 20
Dynamic Adjustment of HS-PDSCH Code Resource .............................................. 21
Dynamic Adjustment of HSDPA Power Resource .................................................. 22
Congestion Scheduling ........................................................................................ 23
Congestion Control for Dual-Cell HSDPA ............................................................... 23
Related Measurement ......................................................................................... 24
Node B Common Measurement............................................................................ 24

5
5.1
5.1.1
5.1.2
5.1.3
5.2
5.2.1

HSUPA Congestion Control Algorithm............................................................... 24
Resource Preemption Policies ............................................................................. 24
Forced Release .................................................................................................. 26
Downgrade for DCH Subscribers........................................................................... 26
Congestion Scheduling ........................................................................................ 26
Related Measurement ......................................................................................... 27
Node B Common Measurement............................................................................ 27

6

MBMS Congestion Control Algorithm ................................................................ 27

7
7.1
7.1.1

Configuration of Parameters............................................................................. 27
Parameter List .................................................................................................... 27
Parameter Configuration ...................................................................................... 28

8
8.1
8.2

Counter And Alarm ........................................................................................... 34
Counter List........................................................................................................ 34
Alarm List .......................................................................................................... 36

9

Glossary ............................................................................................................ 36

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

II

Congestion Control Feature Guide

Figures and Tables
Figure 1

Flow chart of resource preemption ............................................................................5

Figure 2

Flow chart of resource preemption in the HSDPA cell ............................................... 17

Figure 3

Flow chart of HSUPA resource preemption(kyz)....................................................... 24

Table 1

Definition of RAB preemption capability in 3GPP protocols .........................................7

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

III

Congestion Control Feature Guide

1

Function Attributes
System version: [RNC V3.09, OMMR V3.09, Node B V4.09, OMMB V4.09]
Attribute: [Required]
Involved NE:
UE

Node B

RNC

MSCS

MGW

SGSN

GGSN

HLR

√

√

√

√

-

√

-

-

Note:
* -: Not involved
* √: Involved
Dependency: [None]
Mutual exclusion: [None]
Remarks: [None].

2

Overview

2.1

Function Introduction
Congestion control is intended to reallocate radio resources in the case of system
congestion and to relieve the congestion by a series of control measures according to
service attributes, so as to improve the call successful ratio and enable reasonable
utilization of system resources by service priorities.
Congestion occurs when the uplink or downlink load reaches or exceeds the admission
threshold and new service requests cannot access the system due to insufficient
resources. In this case, the RNC needs to activate the congestion control policy. The
service requests include RAB setup, RAB modification or RAB negotiation/re-negotiation,
SRNC incoming relocation, inter-Iur RL setup, intra-RNC soft or hard incoming handover,
incoming inter-system handover, incoming inter-frequency handover, inter-RNC soft
handover, second RAB setup for the same user, and service rate increase triggered by
dynamic adjustment of radio bearer.
The above-mentioned resources include: uplink interference, downlink power, data
throughput, downlink code resources, uplink and downlink Node B‟s CE resources, and
number of HSPA subscribers.
In the event of congestion, the system should not directly reject the service requests, but
release links forcibly, arrange the requests to queue, or decrease the load according to the
requirement of service delay and priority to release some resources and improve the call
successful ratio.
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In the event of system congestion, resource preemption can be triggered to reflect
superiority of subscribers with higher priorities and improve call successful ratio. Its main
policies consist of two aspects as follows:

2.1.1



Forced release: The services capable of preemption with higher priorities are allowed
to release forcibly those services with lower priorities. That is, the subscribers with
higher priorities can implement fast access by preempting the resources of those
subscribers who are of lower priorities and subjected to forced release. This is to
reflect differentiation of services between subscribers.



Downgrade: This policy is used to improve call successful ratio by decreasing the
data bit rate of online subscribers.

Congestion Control for R99
This function supports congestion control of the R99 cells. That is, the congestion control
function is triggered by failure of the R99 services to access for radio resources in the case
of tight supply (congestion).
This function consists of queue scheduling and load decrease. When a cell is congested,
the queues are maintained according to the congestion causes Load decrease means to
make the cells less congested with certain methods. For example, congestion of the R99
services is handled with the methods as follows:

2.1.2



The calls capable of preemption with higher priorities are provided with top priority to
use radio resources by means of forced release of other services and deletion of radio
links.



Some resources are spared for specific congested subscribers by decreasing the
data rate of online DCH.

Emergency Call
For emergency calls, the default value of Pre-emption Capability is „may trigger preemption‟, the default value of Pre-emption Vulnerability is „not pre-emptable‟,Emergency
calls require only hard resource (code and CE resources) admission decision instead of
soft resource admission decision. If the hard resource congestion occurs, the forced
release will be triggered and the online emergency calls can not be forced release.

2.1.3

Directed Retry to GSM
For AMR subscribers, when congestion occurs during their admission due to shortage of
resources, if the RAB have no preemption or queuing capacity, directed retry to 2G will be
triggered; if the RAB have preemption or queuing capacity, the above forced
release/queuing polices will be executed, and directed retry to 2G will be triggered if forced
release and queuing fails
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2.1.4

Congestion Control Strategy for HSDPA
For the HSDPA cells with limited radio resources, congestion control features will
guarantee QoS of subscribers with higher priorities in accordance with service criteria.
Resource congestion is most likely to result from limitation of power resources,
channelization code resources, the CE resource of A-DPCH and number of HSDPA
subscribers. Congestion of services in the HSDPA cells can be cleared by the following
means:

2.1.5



Forced release of resources according to priority



Adjustment of total HSDPA power (when the total power available to HSDPA is
adjusted by RNC dynamically)



Adjustment of code resources for HSDPA



DCH downgrade for the Rel99 services



Channel switch of interactive services and background services over HSDPA to
RACH/FACH

Congestion Control Strategy for HSUPA
For the HSUPA cells with limited radio resources, congestion control guarantees QoS of
subscribers with higher priorities in accordance with service criteria. HSUPA load decrease
is implemented with three congestion control policies as follows:


Forced release of resources according to priority

If the rejected service is capable of preemption, it is allowed to release forcedly other
services with lower priorities.


Decrease of current load

The load of E-DCH subscribers is mainly controlled by Node B, while the RNC controls
only the DCH load. Therefore, DCH downgrade is the only way to decrease the uplink
interference without forced release.


3

Handover of interactive services
RACH/FACH

and background services over HSUPA to

R99 Congestion Control Algorithm
Congestion control is a process of resource preemption, including forced release,
downgrade, and scheduling and admission of queuing subscribers. These policies are
described in detail s in the following sections.
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3.1

Resource Preemption Policies
In the event of system congestion, resource preemption can be triggered to reflect
superiority of subscribers with higher priorities and improve call successful ratio. Its main
policies consist of two aspects as follows:


Forced release: The services capable of preemption with higher priorities are allowed
to release forcibly those services with lower priorities. That is, the subscribers with
higher priorities can implement fast access by preempting the resources of those
subscribers who are of lower priorities and subjected to forced release. This is to
reflect differentiation of services between subscribers.



Downgrade: This policy is used to improve call successful ratio by decreasing the rate
of data services for online subscribers.

A complete description of scenarios and application policies for forced release and
downgrade will be found in later sections.
First it is necessary to introduce the priority definitions used in congestion control. These
definitions will also be referenced in subsequent policy descriptions.


Basic Priority of RNC-BP: It is determined by two factors: ARP (Allocation/Retention
Priority) and Traffic class. ARP is mapped and transferred to the RNC by the core
network QoS, while Traffic Class means the type of the originating service. ZTE RNC
extends the Traffic Class of protocols. Take the Interactive service for example. Its
unique THP (Traffic Handling Priority) is also regarded as a value of Traffic Class for
BP mapping. BP can be used for direct mapping of SPI of Node B and Frame
Handling Priority, and also plays an important part in priority mapping of AP of RNC
and SPI of RNC.



Application Priority of RNC-AP: It is determined by BP, Radio bearer type (with values
of DCH, HSPA, and MBMS), and rate of existing subscribers. In the event of resource
congestion or overload, Application Priority of RNC-AP is used to select
subscribers/services for load decrease, with consideration to the two factors of bearer
type and rate: different bearer types require reflection of priorities, and rate can serve
as a key factor to control fast stabilization of load and fast removal of resource
congestion for a system. For example, when a service of higher rate is selected for
downgrade, the load will decrease faster.



Scheduling Priority of RNC-SP: The scheduling priority used in the RRM policy of the
RNC is determined by BP and radio bearer type, and is used to select subscribers
during forced release and admission of queuing subscribers.



Scheduling Priority of Node B-SPI: SPI of Node B is obtained directly from BP
mapping.

Refer to ZTE UMTS QoS Feature Guide for more detailed mapping relations and
configuration methods and examples of the priorities mentioned above.

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

4

Congestion Control Feature Guide

The overall process of resource preemption policy is as follows:
1

2

For a service that fails to be admitted (excluding those admission failures triggered by
an online rate increase request), forced release is conducted first (to release RAB) in
the case of hard resource congestion if the service has the preemption capability.
i

If the new service request is capable of queuing, the new service request will be
included into the queue to trigger blind downgrade. The blind downgrade means
downgrade according to the numbers of DRBC grades of downgrade configured in
OMC.

ii

If the new service request is incapable of queuing, downgrade of existing
subscribers will be directly triggered once.

For a service that fails to be admitted because of hard resource congestion and it has
no preemption capability, or a service that fails to be admitted because of soft
resource congestion, the judgment is focused directly on whether it is capable of
queuing.
i

If it is capable of queuing, it will be included into the queue to trigger blind
downgrade;

ii

if it is incapable of queuing, downgrade will be directly triggered once. In the case
of soft resource congestion, its handling process is the same as that for “a
service with preemption capability during hard resource congestion".

As for an admission failure triggered by an online rate increase request, the affected
service will be included into the queue directly. For the subsequent handling, refer to later
related sections on 3.1.2 DCH Downgrade and 3.1.3 Congestion Scheduling.
Note 1: The length of the queue mentioned above is controlled by the OMC parameter
QLength. When a service in RAB establishment phase is listed in a queue, the duration
needed for it to wait for scheduling is controlled by the OMC parameter TTrueQ. When a
service in incoming relocation phase is listed in a queue, the duration needed for it to wait
for scheduling is controlled by the OMC parameter TTrueQReloc.
Note 2: For AMR or CS64K services, if RAB assignment message or SRNC relocation
request does not carry queue information or indicate the RAB does not have queue ability,
whether the RAB is allowed to queue or not is dependent on forced queue switch. Forced
queue switch for AMR service is ForcQueSwiAMR, forced queue switch for CS 64kbps
service is ForcQueSwiCS64, maximum time in the queue is TTrueQForced；If the RAB
assignment message or SRNC relocation request
indicate that the RAB has queue
ability, the forced queue switch is not taken effect.
For easier understanding of the sequence of resource preemption policies (forced release
and downgrade), the following presents an overall flow chart of resource preemption with
the process of RAB assignment for a UE as an example.

Figure 1

Flow chart of resource preemption
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RAB Assignment Requet(UE
-A)

CAC is
successful？

Yes

UE-A access

No

Pre-emption Capability is
yes?

To Select UE on line
and perform preemption

Yes

No

No

Queuing Allowed
is yes?

No

Yes

To trigger UEs on line
downgrading and UE-A
‘RAB is failure to access

Put UE-A into the
queue

Pre-emption is
successful？
Yes

UE-A accesses

To trigger UEs on line
downgrading

UE-A is scheduled
by RNC and attempt
to admit again.

Note: The cases of downgrade indicated in the figure above all are DCH downgrade.

3.1.1

DCH Forced Release
The purpose of forced release is to ensure immediate access of subscribers with higher
priorities whenever possible during congestion.
The following will describe the whole process of forced release from the aspects of the
application of interface information during forced release, application scenarios of forced
release, selection of subscribers for forced release, and handling of multi -RAB forced
release.
Note: All the principles to be described below are universal to both uplink and downlink, so
these principles are not differentiated for uplink and downlink.
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The mechanism applied to the IE information at the message interface during forced
release is as follows:
For a service request originated during system congestion, the system can release an
ongoing service forcibly according to service priority and preemption capability. As
specified in 3GPP protocols, the preemption capability is determined by the CN in the
Allocation/Retention Priority information element (IE) in the RAB assignment message or
relocation request message during service setup or in the RL setup message during Iur
handover. If the RAB assignment message or relocation request message or RL setup
message during Iur handover carries no Allocation/Retention Priority information element, it
means this RAB has no preemption capability and can be released forcibly by other RABS
for it has the lowest priority. Such an approach is used because this information element is
an optional parameter for RAB assignment and relocation request, and the RNC needs to
map internally the priority of a message that carries no ARP information for the purpose of
complete processing, In ZTE RNC, for a RAB without ARP information, its basic priority
(BP) is set to 0, which is the lowest priority. Also as specified in 25.413, if the RAB
assignment message carries no ARP, this RAB is regarded by default as incapable of
preemption and subjected to forced release.

Table 1

Definition of RAB preemption capability in 3GPP protocols

Cell

Value

Meaning

Pre-emption
Capability

may trigger pre-emption

The RAB has the forced release capability.

shall not trigger pre-emption

The RAB does not have the forced release
capability.

Pre-emption
Vulnerability

pre-emptable

The RAB can be released by other RABs
forcibly.

not pre-emptable

The RAB cannot be released by other
RABs forcibly.

no priority

The RAB does not have the forced release
capability and cannot be released by other
RABs forcibly.

1~14

The resource allocation priority of the RAB.
The value "1" stands for the highest priority
level.

Priority Level



Application scenarios of forced release

Forced release can be triggered only for RRC connection establishment of emergency call ,
the first RAB assignment (including RT and NRT service assignment), not he first RAB
assignment of emergency call, CS service combined with PS service, incoming relocation
(including 2G-3G handover, and 3G RNC-RNC relocation), CS service calling after PS
service online in the case of hard resource being limited.
If hard resource congestion occurs in the RRC signaling phase that establishment cause
is not emergency call, an additional attempt of access on FACH will be made instead of
triggering forced release.
If hard resource congestion occurs in the RRC signaling phase that establishment cause
is emergency call , forced release will be triggered. If force release is failure, an additional

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

7

Congestion Control Feature Guide

attempt of access on FACH will be made. If hard resource congestion occurs in the RAB
assignment phase for emergency call again, forced release will be triggered again.
If resource congestion occurs in the high speed RRC signaling phase, an attempt of
accessing again in low speed will be conducted. If admission fails again, the congestion
control process will be triggered by the low speed RRC establishment. If the hard resource
congestion occurs, the corresponding forced release process will be triggered based on
the fact the service is emergency cal or not (referring to the description of paragraphs
above for details), otherwise the forced release can not be triggered.
The detail description for the congestion method of PS+CS see “The congestion method
of PS+CS”.
In an R99 cell, hard resources include: downlink channelized resources and uplink and
downlink CE resources. These resources are also the hard resources of CS AMR, CS
Video, PS RT and PS NRT.
Soft resource (like RTWP and TCP) congestion, transmission resource congestion, and
RNC internal congestion will not trigger forced release.


Mechanism of selecting subscribers for forced release

When a subscriber with preemption capability originates forced release, only those
subscribers whose scheduling priorities(SP) are lower than the Scheduling Priority of the
subscriber which trigger the forced release of the RAB and whose RAB has pre-emptable
PVI (Pre-emption Vulnerability) can be treated as targets of forced release.
If a subscriber meets the forced release conditions above, it is also necessary to calculate
whether the resources released from this subscriber can meet the resourc e requirement of
the subscriber who originates this forced release. If yes, this subscriber will be released
forcibly. Otherwise, this subscriber cannot be selected as a target for forced release,
because even release of this subscriber cannot guarantee ac cess of the originator of
forced release. For example, an originator of forced release needs code words with a
Spread Factor (SF) of 64, while the online subscribers with the lowest priority use SF of
128, so these subscribers, even with the lowest priorities(SP), cannot be released forcibly.
Moreover, to avoid extensive call drop of online services, there is a limitation to the number
of subscribers that can be released forcibly by an originator of forced release. If a
subscriber has only one type of hard resource being limited, he/she can release only one
subscriber forcibly. If he/she has more than one type of hard resource being limited, at
most two subscribers can be released forcibly.
A target subscriber for forced release can be an RT or NRT subscriber.


Principles of combining preemption capability and scheduling priorities(SP) in the
multi-RAB case

If the originator of forced release has more than one RAB, the first step is to combine its
preemption capabilities. As long as the originator has one RAB with preemption capability,
it will be regarded as capable of preemption. The scheduling priority (SP) used by the
originator is the highest scheduling priority(SP) among these RABs, and this priority will
be compared with the scheduling priority(SP) of the subscriber to be released forcibly.
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If the subscriber to be released forcibly has more than one RAB, the highest RAB
scheduling priority(SP) will be used as the scheduling priority(SP) for forced release, and
forced release is possible only when all RABs permit forced release (with pre-emptable
PVI).


Execution of forced release

Once the originator of forced release selects a subscriber for forced release, the forced
release will be executed on this subscriber, including deletion of the macro diversity link
from this subscriber‟s congested cell and release of the RAB. If this subscriber has more
than one link and the congested cell is not the best cell, the link of the congested cell will
be deleted. If this subscriber has only one link of the congested cell or the congested cell
is this subscriber‟s best cell, all RABs of this subscriber will be released. Because a
subscriber is released at a speed much larger than that of downgrade and conversion to
FACH, and with a high success ratio, the originator will not be kept waiting for a long time
in the process of access, so as to ensure the access can be completed most quickly.
Those subscribers with preemption capability are a minority of subscribers with top priority
in the network, while those subscribers to be released forcibly are a minority of
subscribers with bottom priorities in the network. The access duration of the subscribers
with high priorities is ensured by sacrificing the online qualification of the subscribers with
low priorities.


Handling of failed forced release

If the originator of forced release fails to select a subscriber for forced release (the reason
of failing to select a subscriber includes: (i)the online subscribers have higher scheduling
priority than originator; (ii) Pre-emption Vulnerability of all online subscribers is not preemptable; (iii)the resource released by the online subscribers can not meet the need of
originator to be admitted), it indicates the forced release is unsuccessful, and the
originator will take different actions depending on whether it has queuing capacity. With
queuing capability, the originator will be included into the queue to trigger downgrade and
wait for rescheduling and admission. Without queuing capacity, the originator is allowed to
trigger downgrade once for later admission or for other subscribers to access directly upon
initiating an access request, while the cell is not overloaded at that time.


Directed retry of AMR subscribers

For AMR subscribers, if congestion occurs during their admission due to shortage of
resources, directed retry to 2G will be triggered if they have no preemption or queuing
capacity. Otherwise, the above forced release/queuing polices will be executed, but
directed retry to 2G will be triggered if forced release and queuing fails.


Resource preemption policy for handover subscribers

For handover subscribers, if admission fails, neither forced release nor queuing will be
conducted, but downgrade can be triggered.


The congestion method of PS+CS

If PS service is on line that RRC status may be CELL_FACH or CELL_DCH and CS
service is calling, PS service will re-allocated minimum DRBC rate and attempt to access
with CS in DCH. If access is failure, PS service will re-allocated 0/0kbps and attempt to
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access with CS in DCH. If access is failure, the CS service is only considered to trigger
congestion.
If Pre-emption Capability IE of CS service is „may trigger pre-emption‟, pre-emption
procedure will be triggered; If pre-emption is failure or Pre-emption Capability IE of CS
service is „shall not trigger pre-emption‟, and it is allowed to queue, downgrade will be
triggered. If it is not allowed to queue, downgrade will be triggered only once.
The CS service include emergency call. For emergency call, the default value of Preemption Capability is „may trigger pre-emption‟, the default value of Pre-emption
Vulnerabilit is „not pre-emptable‟,


Congestion control when cells in different PLMN share the CE resource

Mechanism of selecting subscribers for forced release due to shared CE congestion is
similar to the not shared CE congestion. Both select subscribers from low SP to high SP,
but the selecting scale will be different in congestion scenery.
1

When only local cell CE resource congestion occurred, it will select subscribers for
pre-emption in the local cell.

2

When local cell group CE congestion occurred ( including local cell group CE
congestion and local cell group PLMN CE congestion both occurred ), or only local
cell group PLMN CE congestion occurred, it will select subscribers for pre-emption in
the local cell group self-PLMN and other PLMNs having more CE resource than
(MinCEPercent[1…PLMNNum] + CEneed).

3

When ( 1 ) and ( 2 ) conditions are satisfied together, it will select subscribers for preemption in the local cell self-PLMN and other PLMNs having more CE resource than
( MinCEPercent[1…PLMNNum] + CEneed ).

4

When local cell group CE congestion or local cell group self-PLMN CE congestion
together with other resource congestion occurred (for example, DL code resource
congestion, RTWP congestion, TCP congestion, HSDPA/HUSPA users number
congestion, HS-DSCH data throughput congestion ), it will select subscribers for preemption in the local cell self-PLMN and other PLMNs having more CE resource than
( MinCEPercent[1…PLMNNum] + CEneed ).

Note:
MinCEPercent[1…PLMNNum] indicates PLMN‟s minimum proportion of CE
resource ; CEneed indicates the CE need of the subscriber which trigger the pre-emption.

3.1.2

DCH Downgrade
If the rejected subscribers have no preemption capability or fail to release other
subscribers forcibly, as described in the flow chart of figure 1, downgrade will be triggered
for online services directly if these subscribers have no queuing capability. If they have
queuing capability, they will be included into the queue and trigger downgrade of online
services to spare some resources for the services in the queue or the services to be
admitted later.
Note: All the principles to be described below are universal to both uplink and downlink, so
these principles are not differentiated for uplink and downlink.
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The congestion causes that can trigger downgrade include:


Downlink: limitation of code resources (hard resources), Node B‟s CE resources (hard
resources), power resources (soft resources).



Uplink: limitation of Node B‟s CE resources (hard resources), and uplink interference
(soft resource).

According to the above descriptions, the following scenarios which trigger congestion
could trigger downgrade: RRC setup, RAB setup, RAB modification or RB reconfiguration,
Rel99 DCH bit rate upgrade, incoming SRNC relocation, inter-Iur RL setup, intra-RNC soft
or hard, incoming ISHO, incoming IFHO, incoming HS-DSCH serving cell change, interRNC SHO/HHO, second RAB setup for the same user and so on.
As the services in the queue include newly-admitted services and rate increase service of
online services, the policies to trigger downgrade have different considerations. Newly
admitted services include first RAB assignment, not first RAB assignment of emergency,
CS service in scene of PS service combined CS service and incoming relocated services.
For not the first RAB assignment, the forced release and queuing can not be allowed.
If RRC establishment refused to access to the cell for the resource congestion except the
cause of User Number, the DCH downgrade will be triggered.
In addition, the services without queuing capability and handover services do not queue,
but will also trigger downgrade for the rejecting cell when they are rejected with the same
downgrade policies as those for newly-admitted services. Handover services include intraRNC soft or hard handover, incoming ISHO, incoming IFHO, inter-RNC SHO/HHO.
The services without queuing capacity will still originate downgrade when rejected in an
attempt to enable their subscribers to access later or other subscribers to access directly
upon initiating an access request, while the cell is not overloaded at that time.
If
downgrade
is
triggered
by
the
service
without
queuing
capacity,
congestion_prohibit_timer will be started. The value of congestion_prohibit_timer is 10
seconds. If congestion_prohibit_timer is running, the upgrade request online service will be
rejected. The reason is to avoid ping-pong update bit rate of online service.


Downgrade triggered by newly-admitted services (this policy also applicable to RRC
establishment, the services not allowed to queue and handover services)

Unlike forced release, downgrade is specific to individual RABs. That is, when a subscriber
has more than one concurrent RAB, these RABs are independent of each other without
coupling relationship when they are selected for downgrade.
The time for triggering downgrade: for RRC establishment or handover services or the
services not allowed to queue, downgrade will be triggered once upon rejection of
admission. For the services in the queue, apart from one time of downgrade triggered
respectively when they are included into the queue and when common measurement is
reported, in the case of hard resource limitation, multiple times of downgrade can be
triggered as long as the queue still contains a service with only hard resources limited. If
the queue only contains services with soft resource limited, downgrade can be triggered by
common measurement report only.
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When a newly-admitted service triggers online service downgrade, the principles for
selecting services for downgrade are as follows: the online RABs are sorted according to
application priorities(AP), and then are selected for downgrade in the ascending sequence
of application priorities(AP). At most MaxNumUeOfDecRat RABs can be selected each
time when downgrade is triggered, that is multi-RABs which may be own to different UE
can be triggered to downgrade by a newly-admitted service simultaneity. If multi-RABs
have the same application(AP), the RABs will be selected to downgrade random. As this
downgrade is triggered by a newly-admitted service and a handover service, no comparison
is made here between the comparative application priorities (AP) of the originator that
triggers online service downgrade and the subscriber whose rate is decreased, in order to
guarantee call successful ratio and reduce handover subscribers‟ call drop rate.
Application priorities(AP) reflect basic priority(BP), current service rate, and bearer type.
Their mapping methods and configuration examples can be found in ZTE UMTS QoS
Feature Guide. CS AMR, PS RT, and PS NRT can all be treated as the targets of
downgrade.
When an online service is selected as an RAB for downgrade, its rate to be decreased can
be identified in this way: for PS services, their rate is decreased by several DRBC rate
grades each time. The maximum DRBC rate grades (UlDnMaxStg in the uplink and
DlDnMaxStg in the downlink) that can be decreased each time is configurable at the OMC.
For I/B services, their rate can be decreased to the minimum DRBC rate. For S services,
their rate can be decreased only to a minimum of Guaranteed Bit Rate (GBR).Regarding
the CS AMR services, if Iu-up mode version 2 is adopted, downgrade will be conducted
according to the types of rate assigned by the lu interface. If Iu-up mode version 1 is
adopted, downgrade will be conducted on the basis of the several rate steps allowed by
the RNC. The DRBC rate steps are differentiated for uplink and downlink, and the uplink
and downlink DRBC rate steps are defined in ZTE UMTS DRBC Algorithm Feature Guide.
For detailed applications of the rate steps corresponding to AMR Iu-up mode version 1 and
Iu-up mode version 2, refer to ZTE UMTS WB-AMR Feature Guide.


Downgrade triggered by rate increase request from online services

Downgrade triggered by rate increase request from online services is specific to individual
RABs. That is, when a subscriber has more than one concurrent RAB, these RABs are
independent of each other without coupling relationship when they are selected for
downgrade.
The time of triggering downgrade is the same as that for “Downgrade triggered by newlyadmitted services".
When rate increase request from an online service triggers downgrade for another online
service, to ensure fairness between two subscribers and prevent ping-pong adjustment
between the subscriber who requests downgrade and the subscriber whose rate is
decreased, the policies for downgrade triggered by online services take into comprehensive
consideration these two factors: comparison between current rate and nominal bit rate
(NBR), and application priorities(AP) (based on subscribers‟ current actual rate mapping
assigned). The specific principles are as follows:
1

First all online services (including CS, PS RT and PS NRT) in a cell are divided into
three sets according to the comparison between current rate and NBR. Services at a
current rate smaller than NBR fall into set1, services at a current rate equal to NBR
fall into set2, and services at a current rate larger than NBR fall into set3.
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2

The priority relationship between set1, set2 and set3 is: set1>set2>set3. Specifically,
rate increase request from set1 can trigger service downgrade of set2 and set3, and
rate increase request from set2 can trigger service downgrade of set3. At the same
time, the set into which the service whose rate is increased will fall must have an
equal or smaller application priority(AP) than the set into which the service whose rate
is decreased will fall. For example, service A in set 1 requests rate increase, while
service B belongs to set2. If A falls into set2 after its rate is increased to the target
rate, while B falls into set1 after its rate is decreased, A is not allowed to trigger
downgrade of B. Otherwise, ping-pong adjustment may occur.

3

If the service requesting rate increase and the service available for downgrade belong
to the same set, the former must have a higher application priority (AP) than the latter,
and the former with its rate increased must have an equal or smaller application
priority(AP) than the latter with its downgraded.

NBR is configured separately for uplink and downlink: UlNormBitRate and DlNormBitRate.
When an online service is selected as an RAB for downgrade, its rate to be decreased can
be identified in this way: for all services, their rate is decreased by one step at a time
based on the DRBC rates. Specifically, for I/B services, their rate can be decreased to the
minimum DRBC rate. For S/C services, their rate can be decreased only to a minimum of
Guaranteed Bit Rate (GBR).The DRBC rate steps are differentiated for uplink and downlink,
and the uplink and downlink DRBC rate steps are defined in ZTE UMTS DRBC Algorithm
Feature Guide.
When an online service has its rate being increased, the target rate can be identified as
the DRBC rate immediately above the one higher than the current rate (without
consideration to the restraint of Max Bit Rate). For details, refer to ZTE UMTS DRBC
Algorithm Feature Guide.


Execution of rate increase/decrease

The lub interface adopts the mode of radio link reconfiguration, while the Uu interface
adopts the mode of RB reconfiguration. If UE is in the macro diversity state, the lub
interface will configure more than one link at the same time.
Once congestion occurs to the cell accommodating any one of the macro diversity links,
and this UE is selected as the subscriber for downgrade, all the links of this UE must be
subjected to downgrade. The reason is that the R99 UE is allowed to have only one type of
transmission format and one transmission format set, So it is impossible that different
links have different transmission formats or transmission format sets. The macro diversity
links mentioned above can be one of the follows: all links under the supervision of SRNC,
all links under the supervision of DRNC, and links separated among SRNC and DRNC.


Congestion control when cells in different PLMN share the CE resource

Because we don‟t know the CE released by the rate downgrade, so we select the
downgrade services without considering the CEneed.
1

When only local cell CE resource congestion occurred, it will select subscribers for
downgrade in the local cell.

2

When local cell group CE congestion occurred ( including local cell group CE
congestion and local cell group PLMN CE congestion both occurred ), or only local
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cell group PLMN CE congestion occurred, it will select subscribers for downgrade in
the local cell group self-PLMN and other PLMNs having more CE resource than
(MinCEPercent[1…PLMNNum] + CEneed).
3

When ( 1 ) and ( 2 ) conditions are satisfied together, it will select subscribers for
downgrade in the local cell self-PLMN and other PLMNs having more CE resource
than ( MinCEPercent[1…PLMNNum] + CEneed ).

4

When local cell group CE congestion or local cell group self-PLMN CE congestion
together with other resource congestion occurred (for example, DL code resource
congestion, RTWP congestion, TCP congestion, HSDPA/HUSPA users number
congestion, HS-DSCH data throughput congestion ), it will select subscribers for
downgrade in the local cell self-PLMN and other PLMNs having more CE resource
than ( MinCEPercent[1…PLMNNum] + CEneed ).

Note:
MinCEPercent[1…PLMNNum] indicates PLMN‟s minimum proportion of CE
resource ;
Note 1: The transmission resources at the lub interface and lu interface are allocated
dynamically. Specifically, when transmission resources are congested, bandwidth is
allocated to voice services at the Max Bit Rate (MaxBR), to S services at Guarantee Bit
Rate (GBR), while to I/B services to a minimum extent. When the resources are not
congested, the MaxBR bandwidth assigned by the service is available. That means
transmission resources, when allocated, are subjected to dynamic adjustment based on
resource occupation, and do not involve bandwidth allocation notification between individual
network elements, because judging from message, these two types of resource
congestions do not undergo the process of downgrade. Dynamic allocation of the
transmission resources at the lub interface and lu interface takes into consideration
service features and priorities. For mutual influence between the RT and NRT service rates
based on transmission resources, refer to ZTE UMTS RAN Transmission Overview
Feature Guide.

3.1.3

Congestion Scheduling
In the R99, congestion scheduling means to schedule the queuing newly admitted
subscribers and online subscribers requesting rate increase for readmission according to
scheduling priorities(SP) so that the subscribers with higher scheduling priorities(SP) are
scheduled first to use the resources spared from load decrease.
To improve call successful ratio during readmission of the queuing subscribers, the newly
admitted services are scheduled for readmission first, and then online services requesting
rate increase are admitted. As long as there is a newly admitted service in the queue, no
online service requesting rate increase will be scheduled for admission. Newly admitted
services include assigned services and incoming relocated services.
Newly admitted services are scheduled in the sequence of scheduling priorities (SP of
RNC). A newly admitted service with a higher scheduling priority (SP) will be scheduled
prior to another with a lower scheduling priority(SP). For the mapping policies of
scheduling priorities(SP), refer to ZTE UMTS QoS Feature Guide. When sorting the online
services requesting rate increase, the current rates allocated to these services are taken
into first consideration for the sake of fairness and priorities. The services with a current
rate smaller than the NBR are put into the foremost set (set1), the services with a current
rate equal to the NBR are put into set2, and the services with a current rate larger than the
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NBR are put into the last set (set3). Then the services in each set are sorted according to
their scheduling priorities(SP). The service ranking foremost will be scheduled first.
NBR is configured separately for uplink and downlink: UlNormBitRate and DlNormBitRate.
The time for scheduling queuing services: if the service with the highest scheduling
priority(SP) in the queue is suffering soft resource congestion, scheduling for admission
cannot be started until the common measurement is reported, because the soft resources
are judged on the basis of the common measurement report. If the service with the highest
scheduling priority(SP) in the queue is suffering just hard resource congestion, the queue
services will be rescheduled for admission whenever other online services undergo release
and downgrade. Besides, rescheduling is also triggered when the common measurement
is reported. Therefore, for hard resource limitation, there are more chances of rescheduling
for admission.

3.1.4

Preemption of Resources at lur Interface
As resource congestion is a measure judged by the CRNC to trigger load decrease. If the
CRNC of an UE is DRNC, the CRNC cannot perform downgrade and RAB release for this
UE, but needs to use the lur interface to notify the SRNC which subscribers are available
for downgrade. At present, ZTE‟s lur interface congestion mechanism implements the DCH
downgrade.
When the CRNC detects resource congestion, it is impartial to the UE linked via the lur
interface and this RNC, namely the UE of SRNC, when selecting subscribers (on the same
principles as described in section 3.1.2 DCH Downgrade). However, if a UE linked via the
lur interface is selected as the subscriber for load decrease, only downgrade can be
triggered but forced release can not be triggered.
For the UE at the lur interface, the BP of RNC used by the DRNC is obtained from the
Frame Handling Priority (FHP) in the RL setup request. As the Frame Handling Priority is
obtained by the SRNC from the BP mapping chart, it reflects completely the ARP and
Traffic Class information. However, the lur interface cannot carry the Traffic Handling
Priority, so it is justified to use the FHP for handling.
If the SRNC is not ZTE's RNC, it is also justified that ZTE DRNC uses the Frame Handling
Priority directly as BP, because FHP also reflects the data processing priority of one RAB,
and can be regarded as equivalent to service priority.
According to the downgrade algorithm provided, the followings gives the summary of
handover scenarios which will triggered downgrade or not:
1

For intra-RNC SHO, the RL in non-best cell for a UE can be downgraded by new call
admitted in the non-best cell while congestion occurs in the non-best cell.

2

For intra-RNC SHO, the RL in non-best cell for a UE can be downgraded by new call
admitted in the best cell while congestion occurs in the best cell.

3

For inter-RNC SHO, the RL in DRNC can be downgraded by new call admitted in the
cell under DRNC where congestion occurs in the cell under DRNC.

4

For inter-RNC SHO, the RL in DRNC can be downgraded by new call admitted in
SRNC while congestion occurs in the cell under SRNC.
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5

3.2

For inter-RNC SHO, the RL in DRNC can be downgraded by new SHO request to add
the cell under DRNC to the active set while congestion occurs in the cell under DRNC.

Related Measurement
The common measurement, which is applied to the downgrade and congestion scheduling
polices described above, is introduced in detail as follows.

3.2.1

Node B Common Measurement

3.2.1.1

Measurement of Uplink Interference
The uplink interference is measured by the common measurement of received total
wideband power (RTWP) through the Iub interface. The Node B reports the measurement
result to the RNC periodically. The common measurement period of the RTWP is two
seconds.

3.2.1.2

Downlink Power Measurement
The downlink power is measured by the common measurement of downlink transmitted
carrier power (TCP) through the Iub interface. The Node B reports the measurement result
to the RNC periodically. The common measurement period of the TCP is two seconds.

4

HSDPA Congestion Control Algorithm

4.1

Resource Preemption Policies
For the HSDPA cells, resource preemption policies include dynamic adjustment of the
HSDPA code resources, dynamic adjustment of HSDPA power resources (when the total
power available to the HSDPA adopts the RNC Dynamic Assigning Mode HsdschTotPwrMeth), forced release and DCH downgrade.
During resource congestion, the overall process of resource preemption in the HSDPA
cells is as follows: upon service admission rejection, forced release will be conducted first
depending on the preemption capability of the service. The process of forced release
includes the forced release triggered by limitation of the number of HS-DSCH subscribers,
and the R99 forced release (triggered by Node B‟s CE and code resources). If the forced
release fails or the service has no preemption capability but queuing capability, the service
will be included into the queue, and the DCH downgrade will be triggered first. If the DCH
downgrade also fails, a decision must be made on whether to execute the HS-PDSCH
code resource adjustment or HSDPA power resource adjustment depending on the causes
for congestion. In case of code resource congestion, HS-PDSCH code resource
adjustment will be triggered. In case of power resource congestion, the HS power resource
adjustment will be triggered.
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The following provides detailed descriptions of the flow chart with the RAB assignment as
an example:

Figure 2

Flow chart of resource preemption in the HSDPA cell

RAB Assignment Requet(UE-A )

HS-DSCH’s CAC of
UE-A is successful？

Yes

UE-A is allocated
HS-DSCH channel

No
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Pre-emption Capability is
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No
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Is HS-DSCH’user number
limited?

Perform pre-emption and
select UE to be pre-empted
from all UEs which are
allocated DCH or HS-DSCH
channel

Yes

Perform pre-emption of
HS-DSCH’user number
limited

No

No
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Queuing Allowed is
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To trigger UEs on line
downgrading ,UE-A
‘RAB is failure to
access

Pre-emption is
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Pre-emption is
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Put UE-A into the
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HS-DSCH channel
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UE-A will try to
access on DCH again
No

UE-A is allocated
HS-DSCH channel

To trigger UEs on line
downgrading

DCH’s access is
successful？
Yes

Downgrading is
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UE-A is scheduled
by RNC and attempt
to admit again.

No
UE-A is allocated
DCH channel

Is the congestion cause
No
throughput limited or
the
congestion cause
code resource limited？
is power limited
Yes

To trigger HS-PDSCH
‘code update

To trigger HS-DSCH’s
power update when HSDSCH’ power is allocated
by RNC dynamically

Note: The cases of downgrade indicated in the figure above are all DCH downgrade cases.
The following describes specific resource preemption policies.
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4.1.1

Forced Release
For the HSDPA cells, the basic principles of forced release are the same as those for the
R99 forced release.
Compared with the R99 cell, the HSDPA cell has several increments changed as follows:
The causes for resource congestion are extended:
1

Hard resources: There is additional limitation to the number of HSDPA subscribers,
that is, an additional scenario where forced release is triggered by limitation of the
number of HSDPA subscribers. The hard resources that can trigger forced release
include: downlink channelized code resources, uplink and downlink Node B‟s CE
resources, and limitation of number of HS-DSCH services. The principles for forced
release of downlink channelized code resources, and uplink and downlink CE
resources are the same as those described in section 3.1.1 "DCH Forced Release“.
All online subscribers (including the DCH and HS-DSCH subscribers) in the cell are
all subjected to forced release. Pre-emption triggered by the shared CE resource
congestion in HSDPA cell refers to the “3.1.1 DCH Forced Release”.

2

Soft resources: There is additional limitation to the HS-DSCH data throughput, and
the other soft resources are the same as those of the R99, including power and
RTWP.

3

The HS-DSCH data throughput congestion triggers only dynamic adjustment of HS PDSCH code codes, while congestion of the other resources can trigger DCH
downgrade.

4

When a streaming service over the HS-DSCH in a cell cannot meet its QoS (that is,
when the HS-DSCH Required Power reported by Node B indicates that the power
needed is smaller than the power available to this streaming service), forced release
will be triggered for those HS-DSCH services with a low scheduling priority(SP) (the
specific principles are described below in detail.)

5

For the HSDPA cells, HS-DSCH and DCH channels exist on the downlink. When
there are coexisting services over the HS-DSCH and DCH bearers in a subscriber cell,
it is necessary to consider priorities of the bearer channels. Therefore, the application
priorities(AP) used for forced release need to be mapped, according to the channel
types allocated to the services, from the mapping chart of the application priorities (AP)
configured by the OMC.

6

Execution of forced release: If a subscriber allocated HS-DSCH channel is selected
to be released forcibly and if the congested cell is HS-DSCH serving cell of the
subscriber, the RAB will be released;If a subscriber allocated HS-DSCH channel is
selected to be released forcibly and if the congested cell is not HS-DSCH serving cell
of the subscriber, the radio link will be deleted. If a subscriber allocated DCH channel
is selected to be released forcibly, the execution of forced release is the same as that
described in section 3.1.1 "DCH Forced Release“.

The following provides a detailed description of the forced release policies specific to
change of these increments:
7

Policies for forced release triggered by limitation of the number of HS -DSCH
subscribers
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As the HS-DSCH usually has a high data rate, ZTE considers that the subscribers with
higher priorities should be admitted to the HS-DSCH first. Therefore, if the HS-DSCH
cannot be allocated due to limitation of the number of HS-DSCH subscribers, the first step
is to sort the online subscribers already with the HS-DSCH channel allocated. If there is a
subscriber with a lower scheduling priority(SP) than the HS-DSCH requesting subscriber,
this lower-priority HS-DSCH subscriber will be triggered to migrate to the CELL_FACH. If
there is no subscriber with a lower scheduling priority(SP) than the HS-DSCH requesting
subscriber, it is suggested to attempt admission on the DCH again. If the admission of
DCH also fails, the resource preemption should be executed, but the targets for forced
release are all online subscribes in the cell (including the DCH and HS-DSCH subscribers).
The scenarios where forced release is triggered by limitation of the HS-DSCH subscribers
include: first RAB assignment, not first RAB assignment of emergency call and incoming
relocation.
The originator of forced release defined in the policies for forced release triggered by
limitation of the number of HS-DSCH subscribers must have preemption capability, and the
scarified subscriber must allow forced release too.
The contractual policies for the originator of forced release with more than one RAB and
the subscriber released forcedly are the same as the multi-RAB combining policies in
section 3.1.1 "DCH Forced Release“.
8

Forced release triggered by failure of the streaming service on the HS-DSCH to meet
QoS

When the HSDPA Total Power is allocated dynamically by the RNC, on the conditions
that the HS-DSCH Required Power is larger than the HS-PDSCH and HS-SCCH Total
Power, or the HS-DSCH Required Power is larger than the Node B safety threshold (Node
BSafeThr) – NoHsdschTcp, the following load decrease measures will be executed in
sequence: first the DCH subscriber downgrade is triggered. When the downgrade is
completed, if the conditions above are still satisfied, a subscriber suitable for switch to the
DCH or forced release will be selected for DCH channel switch (since this is a service with
guaranteed rate, it is switched only to the DCH). If the DCH succeeds in admission,
channel switch will be executed. If the channel switch fails, forced handover will start. If
forced handover fails, the related RABs will be released. In the procedure above, the HSDSCH Required Power is reported by Node B through the common measurement.
In the Node B Assigning Mode, on the condition that the HS-DSCH Required Power is
larger than the Node B safety threshold (Node BSafeThr) – NoHsdschTcp, the following
load decrease measures will be executed in sequence: first the DCH subscriber
downgrade is triggered. When the downgrade is completed, if the condition above is still
satisfied, a subscriber suitable for switch to the DCH or forced release will be selected for
DCH channel switch (since this is a service with guaranteed rate, it is switched only to the
DCH). If the DCH succeeds in admission, channel switch will be executed. If channel
switch fails, forced handover will start. If the forced handover fails, the related RABs will be
released.
The principles to select target subscribers of channel switch, forced handover, or RAB
release: sort the HS-DSCH Required Power of RABs with guaranteed rate based on the
Node B report in the descending sequence, and start ergodic process from the beginning.
Then calculate whether the HS-DSCH Required Power is smaller than or equal to the
HSDPA Total Power after deletion of all RABs corresponding to one priority (SP) of the UE.
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If yes, stop selection, and the selected subscribers will undergo subsequent operations. If
not, continue selection.
Upon completion of selecting subscribers, the selected subscribers will be switched to the
DCH one by one. If channel switch fails (DCH admission rejected), inter-frequency
handover will be executed. If inter-frequency handover is impossible to be executed, the
related RAB will be released.
The subscriber selection that triggers DCH downgrade and the downgrade principles are
the same as those in section 3.1.2 "DCH “.
Note: The Node B reports the HS-DSCH Required Power of each UE with different
Scheduling priorities(SP). If a UE has several RABs with guaranteed rate and the same
scheduling priority(SP), the system cannot differentiate them. In this case, the system
migrates the channels or releases the related radio links or RABs of all. If the RABs of a
UE are of different priorities(SP), the system can differentiate them and sequence them
separately.

4.1.2

DCH Downgrade
If the rejected subscribers have no preemption capability or fail to release other
subscribers forcibly, as described in the flow chart of figure 2, downgrade will be triggered
for online services directly if these subscribers have no queuing c apability. If they have
queuing capability, they will be included into the queue and trigger downgrade of online
services to spare some resources for the services in the queue or the services to be
admitted later.
All the principles for DCH downgrade in the HSDPA cell are the same as those for DCH
downgrade in the R99 cell (refer to 3.1.2 "DCH “).
DCH downgrade triggered by the shared CE resource congestion in HSDPA cell refers to
3.1.2 "DCH “.
Note: The differences involved below are effective only to the downlink. As the uplink in the
HSDPA cell is supported to use the DCH, the principles for the uplink are totally the same
as those for the DCH downgrade.
The HSDPA cell is different from the R99 cell as follows:


For the HSDPA cell, the downlink needs to initiate the two common measurements of
NoHsdschTCP and HS-DSCH Required Power.



There is an additional scenario where the DCH downgrade is triggered.

1

When the HSDPA Total Power is allocated dynamically by the RNC, on the
conditions that the HS-DSCH Required Power is larger than the HS-PDSCH and HSSCCH Total Power, or the HS-DSCH Required Power is larger than the Node B safety
threshold (Node BSafeThr) – NoHsdschTcp, the following load decrease methods will
be executed in sequence: first the DCH subscriber downgrade is triggered. When
downgrade is completed, if the conditions above are still satisfied, a subscriber
suitable for switch to the DCH or forced release will be selected for DCH channel
switch (since this is a service with guaranteed rate, it is swtiched only to the DCH). If
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the DCH succeeds in admission, channel switch will be executed. If channel switch
fails, forced handover will start. If forced handover fails, the related RABs will be
released.
2

In the Node B Assigning Mode, DCH downgrade will be triggered when any of the
following conditions is satisfied:
i

If HS-DSCH Required Power is larger than the Node B safety threshold (Node
BSafeThr) – NoHsdschTcp, the following load decrease measures will be
executed in sequence: first the DCH subscriber downgrade is triggered. When
the downgrade is completed, if the condition above is still satisfied, a subscriber
suitable for switch to the DCH or forced release will be selected for DCH channel
switch (since this is a service with guaranteed rate, it is switched only to the
DCH). If the DCH succeeds in admission, channel switch will be executed. If
channel switch fails, forced handover will start. If forced handover fails, the related
RABs will be released.

ii

When the NoHsdschTCP common measurement is reported, and there is any
HS-DSCH subscriber, the downlink downgrade algorithm will be started (to
decrease the downlink DCH rate) if MinHsdpaPower (MinHspaPwrRto) +
NoHsPower is larger than the Node B safety threshold. Where, MinHsdpaPower
is the minimum power reserved for the HSDPA subscriber and configured by the
background. NoHsPower is the result of the common measurement reported by
Node B.

NoHsdschTcp is obtained from the common measurement (Transmitted carrier power of all
codes not used for HS-PDSCH or HS-SCCH transmission) reported by Node B.

4.1.3

Dynamic Adjustment of HS-PDSCH Code Resource
When DCH downgrade fails, the HS-PDSCH code resource adjustment will be triggered in
the event of code resource congestion.
The HS-PDSCH code resource adjustment includes HS-PDSCH code resource extension
and reduction.


If the HS-DSCH admission is rejected due to limitation of data throughput, it indicates
the code resource currently allocated to the HS-PDSCH are insufficient, and dynamic
increase of the number of HS-PDSCH will be triggered (for detailed policies, refer to
ZTE UMTS Code Resource Feature Guide.)



In the case of DPCH resource congestion, it indicates there are insufficient DPCH
resources, and decrease of the number of HS-PDSCH will be triggered while
guaranteeing the basic data rate of HSDPA (note: basic rate refers to a sum of the
guaranteed bit rates of the services with guaranteed bit rates over the HS -DSCH). For
detailed adjustment policies, refer to ZTE UMTS Code Resource Feature Guide.

The HS-PDSCH code resource reduction refers to the HSDPA downgrade of the whole cell,
without involving selection of a single subscriber for downgrade from the RNC angle. After
reduction, the HS-PDSCH code resource ultimately has an influence on the code resource
allocation to the HSDPA subscribers of Node B. That means there are fewer code
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resources available for scheduling by Node B. As a result, the total HSDPA throughput is
decreased. The influence of reducing code resource on each UE certainly takes into
consideration the SPI of Node B. For more details, refer to ZTE UMTS HSDPA
Introduction Feature Guide.
The process of dynamic adjustment of the HS-PDSCH code resources takes into overall
consideration the needs for both HSDPA and R99 services. That means when the HSDPA
code channels can only satisfy the GBR needs for the HSDPA service, the R99 service is
not allowed to trigger reduction of the HSDPA code channel. When the HSDPA service
triggers downgrade of the R99 service, the ultimate rate of the R99 service can only be
decreased to its minimum rate (refer to 3.1.2 "DCH “.)Refer to ZTE UMTS Code Resource
Feature Guide for more detailed policies for code resource adjustment performed for the
sake of subscribers‟ QoS when the code resource between the R99 and HSDPA are
shared.

4.1.4

Dynamic Adjustment of HSDPA Power Resource
When DCH downgrade fails, the HSDPA power resource adjustment will be triggered in the
event of power resource congestion.
The HS-PDSCH power resource adjustment triggered by the RNC is effective only when
the HSDPA power allocation method (HsdschTotPwrMeth) adopts the RNC dynamic
allocation mode, which is reflected in two aspects as follows:


When the HS-DSCH admission is rejected due to limitation of power resource, it
indicates the power needed by the HSDPA is congested, and dynamic increase of the
HSDPA power resources will be triggered (for detailed policies, refer to ZTE UMTS
Power Control Feature Guide.)



When the DPCH subscribers are limited due to power resource, dynamic decrease of
the quantity of available HSDPA power resources will be triggered (for detailed policies,
refer to ZTE UMTS Power Control Feature Guide.)

The following scenarios may cause congestion because of limitation of power resource:
RRC setup, RAB setup, RAB modification or RB reconfiguration, Rel99 DCH bit rate
upgrade, incoming SRNC relocation, inter-Iur RL setup, intra-RNC soft or hard, incoming
ISHO, incoming IFHO, incoming HS-DSCH serving cell change, inter-RNC SHO/HHO,
second RAB setup for the same user and so on.
The mechanism for handling the mutual influence between the HSDPA and non-HSDPA
services is reflected on two aspects as follows:


For the HSDPA services with GBR, if the power available to the HSDPA cannot meet
the minimum requirement (common measurement report of HS-DSCH Required Power)
of the GBR service, the downgrade of the R99 PS services will be triggered (both the
NRT and RT PS are subjected to downgrade, but the R99 RT service must guarantee
its GBR.)



In case of co-carrier support of HSDPA, available minimum power (MinHspaPwrRto)
should be reserved for the HSDPA service. If the actual power available to the HSDPA
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is smaller than the minimum power that should be reserved, it is also necessary to
trigger the R99 PS service for downgrade. That means it is also allowed to reserve a
part of power for a service without GBR.

4.1.5

Congestion Scheduling
For the cells that support HSDPA, the congestion scheduling policies are the same as
those in 3.1.3 "Congestion Scheduling“.

4.1.6

Congestion Control for Dual-Cell HSDPA
Services number based congestion control:


For single carrier HS-DSCH subscriber, if the services number congestion in target
carrier, it will execute pre-emption triggered by the HS-DSCH service number
limitation, referring to “4.1.1 Forced Release”.



For double carriers HS-DSCH subscriber, it will execute pre-emption triggered by the
HS-DSCH service number limitation in the congestion carrier, referring to “4.1.1
Forced Release”.

HS-DSCH data throughput based congestion control:


For single carrier HS-DSCH subscriber, if HS-DSCH data throughput congestion in
target carrier, it will execute dynamic adjustment of HS-PDSCH code resource
procedure in target carrier, referring to “ 4.1.3 Dynamic Adjustment of HS-PDSCH
Code Resource “. If HS-DSCH data throughput congestion in double carriers, it will
execute dynamic adjustment of HS-PDSCH code resource procedure in double
carriers, referring to “ 4.1.3 Dynamic Adjustment of HS-PDSCH Code Resource “.



For double carrier HS-DSCH subscriber, if HS-DSCH data throughput congestion in
double carriers, it will execute dynamic adjustment of HS -PDSCH code resource
procedure in double carriers, referring to “ 4.1.3 Dynamic Adjustment of HS-PDSCH
Code Resource “.

TCP based congestion control:


For single carrier HS-DSCH subscriber, if TCP congestion in target carrier, it will
execute DCH downgrade procedure in target carrier, referring to “4.1.2 DCH
Downgrade”. If TCP congestion in double carriers, it will execute DCH downgrade
procedure in double carriers, referring to “4.1.2 DCH Downgrade”.



For double carrier HS-DSCH subscriber, if TCP congestion in double carriers, it will
execute DCH downgrade procedure in double carriers, referring to “4.1.2 DCH
Downgrade”.
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4.2

Related Measurement

4.2.1

Node B Common Measurement

4.2.1.1

Downlink Power Measurement
The HS-DSCH congestion control needs the common measurement information of HSDPA
related Node B, including HS-DSCH Required Power and Transmitted carrier power of all
codes not used for HS-PDSCH or HS-SCCH transmission (NoHsdschTcp). Therefore,
these common measurements must be enabled in the cells that support HSDPA.
All the common measurements above are reported at the intervals of two seconds.

5

HSUPA Congestion Control Algorithm

5.1

Resource Preemption Policies
For the HSUPA cells, the resource preemption policies consist of forced release and DCH
rate increase.
During resource congestion, the overall process of resource preemption in the HSDPA
cells is as follows: for a service that fails to be admitted (excluding those admission
failures triggered by an online rate increase request), forced release is conducted first (to
release RAB) in the case of hard resource congestion if this is a service with preemption
capability. If the forced release fails, the service will be included into the queue to trigger
blind downgrade if it is capable of queuing. If it is incapable of queuing, downgrade will be
directly triggered once. For a service that fails to be admitted because of hard resource
congestion and it has no preemption capability, or a service that fails to be admitted
because of soft resource congestion,, the judgment is focused directly on whether it is
capable of queuing. If it is capable of queuing, it will be included into the queue to trigger
blind downgrade; if it is incapable of queuing, downgrade will be directly triggered once. In
the case of soft resource congestion, its handling process is the same as that for “a
service without preemption capability during hard resource congestion".
For the HSUPA cells, as the E-DCH resources are scheduled at Node B,and DCH
resources are scheduled at the RNC, the current policy is that E -DCH uses remaining
DCH resources.
The following provides detailed descriptions of the flow chart with the RAB assignment as
an example:

Figure 3

Flow chart of HSUPA resource preemption(kyz)

ZTE Confidential Proprietary

© 2010 ZTE Corporation. All rights reserved.

24

Congestion Control Feature Guide

RAB Assignment Requet(UE
-A)

E-DCH CAC is
successful？

Yes

UE-A is allocated
E-DCH channel

No

DCH CAC is
successful？

Yes

UE-A is allocated
DCH channel

No

Pre-emption Capability is
yes?

To Select UE on line
and perform preemption

Yes

No

No

Queuing Allowed
is yes?

No

Yes

To trigger UEs on line
downgrading and UE-A
‘RAB is failure to access

Put UE-A into the
queue

Pre-emption is
successful？
Yes

UE-A accesses

To trigger UEs on line
downgrading

UE-A is scheduled
by RNC and attempt
to admit again.

Note: The cases of downgrade indicated in the figure above all mean DCH downgrade.
The following describes specific resource preemption policies.
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5.1.1

Forced Release
For a cell that supports HSUPA, its downlink supports HSDPA, and HSUPA is introduced
onto its uplink, so the principles for the downlink forced release policies are the same as
the force policies in section 4.1.1 "Forced Release.”
The basic forced release principles on the uplink are all the same as the R99 forced
release principles, so this section describes only the uplink differences compared with the
R99.
The causes for resource congestion are extended:


Hard resources: There is an additional limitation of number of HSUPA subscribers, so
the hard resources that can trigger force release include: downlink channelized code
resources, uplink and downlink Node B‟s CE resources, and limitation of number of EDCH services. The principles for forced release of limitation of number of E -DCH
services, downlink channelized code resources, and uplink and downlink CE
resources are the same as those described in section 3.1.1 "DCH Forced Release“.
All online subscribers (including the DCH and E-DCH subscribers) in the cell are all
subjected to forced release.



Soft resources: Limitation of uplink interference based on the RSEPS measurement

DCH downgrade is likely to be triggered by congestion of both hard and soft congestion.
Pre-emption triggered by the shared CE resource congestion in HSUPA cell refers to the
“3.1.1 DCH Forced Release”.

5.1.2

Downgrade for DCH Subscribers
The load of E-DCH subscribers is mainly controlled by the Node B, while the RNC controls
only the DCH load. Therefore, to decrease the uplink interference without forced release,
the algorithm has no alternative but to deal with the DCH. The policy is the same as that of
DCH downgrade described in 3.1.2 DCH “.
DCH downgrade triggered by the shared CE resource congestion in HSUPA cell refers to
3.1.2 "DCH “.

5.1.3

Congestion Scheduling
For the cells that support HSUPA, the congestion scheduling policies are the same as
those in 3.1.3“Congestion Scheduling“.
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5.2

Related Measurement

5.2.1

Node B Common Measurement

5.2.1.1

Measurement of Received Scheduled E-DCH Power Share (RSEPS)
For the HSUPA cell, if the services are rejected for the reason of uplink interference limited,
there are two possible factors: 1. the sum of all scheduled E-DCH power generated by the
GBR part is too high; 2. the sum of all DCH power and no scheduled E -DCH power is too
high. The RTWP of the cell and the RTWP of the scheduled E-DCH can be measured
through the Node B common measurement of RSEPS.
For the cells that support HSUPA, the power limit based E -DCH congestion control
requires that the Node B periodically reports the HSUPA power related Node B common
measurement information of RSEPS. The common measurement of the uplink RTWP is
reported at the intervals of two seconds.

6

MBMS Congestion Control Algorithm
Refer to ZTE UMTS MBMS Feature Guide.

7

Configuration of Parameters

7.1

Parameter List
Abbreviated name

Parameter name

MaxNumUeOfDecRat

Maximum Number of UE Decreasing Rate When Congestion

UlNormBitRate

DCH Uplink Nominal Bit Rate(kbps)

DlNormBitRate

DCH Downlink Nominal Bit Rate(kbps)

HsdschTotPwrMeth

HSPA Total Downlink Power Allocation Method

MinHspaPwrRto

Minimum HSPA Total Downlink Power

Node BSafeThr

Safe Threshold for Node B

TTrueQ

Time of True Queue for Congested Service in RAB Setup
Process

TTrueQReloc

Time of True Queue for Congested Service Relocating into
UTRAN

QLength

True Queue Length

UlDnMaxStg

Maximum Number of Degraded Uplink Load Steps Every
Time

DlDnMaxStg

Maximum Number of Degraded Downlink Load Steps Every
Time
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MinCEPercent

Minimal percent of CE can be used by the PLMN

ForcQueSwiAMR

Forced Queue Switch for AMR Service

ForcQueSwiCS64

Forced Queue Switch for CS 64kbps service

TTrueQForced

Maximum Time in the True Queue when Service be Forced
into Queue

7.1.1

Parameter Configuration

7.1.1.1

Maximum Number of UE Decreasing Rate When Congestion


OMC Path

Path: View->Configuration Management->RNC NE->RNC Radio Resource Management>Utran Cell->Utran Cell XXX->Modify Advanced Parameter->Load Control Relationship ->
Maximum Number of UE Decreasing Rate When Congestion


Parameter configuration

This parameter is used when load decrease is triggered. It is used to select the number of
subscribers over the uplink/downlink DCH according to the current congestion status.
Increasing this parameter for load decrease can increase the number of DCH subscribers
who can be selected each time for downgrade and accordingly increase the quantities of
resources to be released.
Decreasing this parameter may decrease the number of DCH subscribers who can be
selected each time for downgrade and accordingly decrease the quantities of resources to
be released.
The default value is “3”.

7.1.1.2

DCH Uplink Nominal Bit Rate(kbps)


OMC Path

Path: View->Configuration Management->RNC NE->Qos Configuration->Priority and Rate
Segment Related Qos Advanced Parameter->Check and Modify ->DCH Uplink Nominal Bit
Rate


Parameter configuration

This parameter is mainly used for DRBC queue scheduling, congestion control and load
control. During downgrade by load decrease, DRBC queue scheduling, and load control,
calculation of the priority of the UE whose rate is decreased is related to nominal bit rate.
This parameter indicates the nominal bit rate for uplink interactive/background services,
and is related to basic priority. Each type of basic priority corresponds to associated
nominal bit rate.
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Default configuration is [8, 8, 8, 8, 8, 16, 16, 16, 16, 16, 16, 64, 64, 64, 64, 64] kbps.
Increasing the nominal bit rate of a basic priority tends to increase the downgrade
selection priority of the UE whose rate is decreased during downgrade by load decrease,
DRBC queue scheduling, and load control.
Decreasing the nominal bit rate of a basic priority tends to decrease the downgrade
selection priority of the UE whose rate is decreased during downgrade by load decrease,
DRBC queue scheduling, and load control.

7.1.1.3

DCH Downlink Nominal Bit Rate(kbps)


OMC Path

Path: View->Configuration Management->RNC NE->Qos Configuration->Priority and Rate
Segment Related Qos Advanced Parameter->Check and Modify-> DCH Downlink Nominal
Bit Rate


Parameter configuration

This parameter is mainly used for DRBC queue scheduling, congestion control and load
control. During downgrade by load decrease, DRBC queue scheduling, and load control,
calculation of the priority of the UE whose rate is decreased is related to nominal bit rate.
This parameter indicates the nominal bit rate for downlink interactive/background services,
and is related to basic priority. Each type of basic priority corresponds to associated
nominal bit rate.
Default configuration is [8, 8, 8, 8, 8, 16, 16, 16, 16, 16, 16, 64, 64, 64, 64, 64] kbps.
Increasing the nominal bit rate of a basic priority tends to increase the downgrade
selection priority of the UE whose rate is decreased during downgrade by load decrease,
DRBC queue scheduling, and load control.
Decreasing the nominal bit rate of a basic priority tends to decrease the downgrade
selection priority of the UE whose rate is decreased during downgrade by load decrease,
DRBC queue scheduling, and load control.

7.1.1.4

HSPA Total Downlink Power Allocation Method


OMC Path

Path: View->Configuration Management->RNC NE-> RNC Radio Resource Management->
Advanced Parameter Manager->Hspa Configuration information -> HSPA Total Downlink
Power Allocation Method


Parameter configuration

This parameter indicates the allocation method for total power on the HSPA downlink.
There are three methods:
If this parameter is configured to “0”, it means the RNC Static Assigning Mode;
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If this parameter is configured to “1”, it means the RNC Dynamic Assigning Mode;
If this parameter is configured to “2”, it means the Node B Assigning Mode.
The default value is “2”.

7.1.1.5

Minimum HSPA Total Downlink Power


OMC Path

Path: RNC Radio Resource Management->UltranCell->UltranCellXXX-> Modify Advanced
Parameter->Hspa Configuration Information In A Cell-> Minimum HSPA Total Downlink
Power(%)


Parameter configuration

This parameter indicates the minimum value of the total transmission power allocated to
HS-PDSCH, HS-SCCH, E-AGCH, E-RGCH and E-HICH code resource. It is effective only
in the RNC Dynamic Assigning Mode, and its default is 20% of the downlink transmission
power of the cell.
Increasing this parameter can increase the total transmission power available to HS PDSCH, HS-SCCH, E-AGCH, E-RGCH and E-HICH codes.
Decreasing this parameter can decrease the total transmission power available to HSPDSCH, HS-SCCH, E-AGCH, E-RGCH and E-HICH codes.

7.1.1.6

Safe Threshold for Node B


OMC Path

Path: Path: View->Configuration Management->RNC NE->RNC Radio Resource
Management->UltranCell->UltranCellXXX-> Modify Advanced Parameter->Load Control
Relationship-> Safe Threshold for Node B(%)


Parameter configuration

This parameter indicates the threshold for safe use of the HSDPA power in the Node B
Assigning Mode, namely the permissible maximum value set by the system. The power
used by HSDPA should be under instead of above this threshold at any time.
Decreasing this parameter will decrease the maximum HSDPA power available to Node B.
At present, this parameter has been up to the maximum value of the Node B side, so it is
meaningless to increase it.

7.1.1.7

Time of True Queue for Congested Service in RAB Setup Process


OMC Path
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Path: View->Configuration Management->RNC NE->RNC Radio Resource Management->
Advanced Parameter Manager->Global Access Control-> Time of True Queue Congested
Service in RAB Setup Process


Parameter configuration

This parameter indicates the maximum time length that a call can stay in the true queue in
RAB setup process. When queuing longer than this parameter, the subscriber will fall out
of the true queue. Ranging from 0~60s, it is configured to 10s by default.
Decreasing this parameter will shorten the maximum queuing time of a call in the true
queue, making it more likely to fall out of the queue.
This parameter must be smaller than or equal to the timer duration of the RAB response of
CN. At present, the CN default value is 10s, so this parameter is effective when it is
smaller than or equal to 10s. It is inadvisable to increase this configuration.

7.1.1.8

Time of True Queue for Congested Service Relocating into UTRAN


OMC Path

Path: View->Configuration Management->RNC NE->RNC Radio Resource Management> Advanced Parameter Manager -> Global Access Control-> Time of True Queue for

Congested Service Relocating into UTRAN


Parameter configuration

This parameter indicates the maximum time length that a call can stay in the true queue
when relocation into UTRAN. When queuing longer than this parameter, the subscriber will
fall out of the true queue. Ranging from 0~60s, it is configured to 4s by default.
Decreasing this parameter will shorten the maximum queuing time of a call in the true
queue, making it more likely to fall out of the queue.
Increasing this parameter will increase the maximum queuing time of a call in the true
queue, making it difficult to fall out of the queue.

7.1.1.9

True Queue Length


OMC Path

Path: View->Configuration Management->RNC NE->RNC Radio Resource Management->
Advanced Parameter Manager->Global Access Control-> True Queue Length


Parameter configuration

This parameter indicates the length of the true queue. If the true queue is longer than this
parameter, the congested subscribers cannot enter the true queue. Ranging from 0~32, it
is configured to 16 by default.
Increasing this parameter can increase the length of the true queue.
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Decreasing this parameter can decrease the length of the true queue.

7.1.1.10

Maximum Number of Degraded Uplink Load Steps Every Time


OMC Path

Path: View->Configuration Management->RNC NE->RNC Radio Resource
Management->Utran Cell->Utran Cell XXX->Modify Advanced Parameter->Load
Control Relationship ->Maximum Number of Degraded Uplink Load Steps Every
Time


Parameter configuration

This parameter specifies the maximum number of DRBC rate steps that can be decreased
at a time during the implementation of the load decrease measures in the uplink. You can
configure the parameter in reference to the configuration of DRBC uplink rate steps.
Provided that the number of uplink DRBC rate grades is set to 2 grades [64 384], the
current bit rate is 384kbit/s and the parameter is set to 1. If the uplink rate is decreased by
1 step, the rate is decreased to 64kbit/s. Provided that the number of uplink DRBC rate
grades is set to 3 grades [64 128 384], the current bit rate is 384kbit/s, and the parameter
is set to 1. If the uplink rate is decreased by 1 step, the rate is decreased to 128kbit/s. if
the parameter is set to 2, the rate is decreased by 2 steps to 64kbit/s. By default, the
settings is 1 step

7.1.1.11

Maximum Number of Degraded Downlink Load Steps Every Time


OMC Path

Path: View->Configuration Management->RNC NE->RNC Radio Resource
Management->Utran Cell->Utran Cell XXX->Modify Advanced Parameter->Load
Control Relationship -> Maximum Number of Degraded Downlink Load Steps Every
Time


Parameter configuration

This parameter specifies the maximum number of degraded downlink load steps at a time
during the implementation of the load decrease measures in the downlink. You can
configure the parameter in reference to the configuration of DRBC downlink rate grades.
Provided that the number of downlink DRBC rate grades is set to 4 [8 64 128 384], and the
current bit rate is 384kbit/s. If the parameter is set to 1 step, the downlink rate is
decreased by 1 grade to 128kbit/s. If the parameter is set to 2 steps, the rate is
decreased by 2 steps to 64kbit/s. If the parameter is set to 3 steps, the rate is decreased
by 3 steps to 8kbit/s. By default, the setting is 1 step.

7.1.1.12

Minimal percent of CE can be used by the PLMN


OMCR

Path: View->Configuration Management->RNC NE->RNC Radio Resource
Management->NodeB Configuration Information->NodeB Configuration Information
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XXX->Number of PLMN for RAN Sharing: Mininal percent of CE can be used by the
PLMN


Parameter configuration

This parameter indicates the minimal percent of CE of the PLMN. Increasing this parameter, the
PLMN will occupy more CE resource and the congestion will occur less possibly. Decreasing
this parameter, the PLMN will occupy less CE resource and the congestion will occur more
possibly.

7.1.1.13

Forced Queue Switch for AMR Service


OMCR

Path ： View->Configuration

Management->RNC NE->RNC Radio Resource

Management-> Advanced Parameter Manager->Global Access Control->Forced
Queue Switch for AMR Service


Parameter configuration

This parameter indicates the forced queue switch for AMR service. In the condition
that there is no queue information or the RAB be assigned has no queue ability in
the AMR RAB assignment information, if the forced queue switch is opened, then
this AMR RAB has the queue ability.
If RAB assignment message or SRNC relocation request does not carry queue information
or indicate the RAB does not have queue ability. Operator can open the switch to improve
the KPI.

7.1.1.14

Forced Queue Switch for CS 64kbps service


OMCR

Path ： View->Configuration Management->RNC NE->RNC Radio Resource
Management-> Advanced Parameter Manager->Global Access Control->Forced
Queue Switch for CS 64kpbs service


Parameter configuration

This parameter indicates the forced queue switch for CS 64kbps service. In the
condition that there is no queue information or the RAB be assigned has no queue
ability in the CS 64kbps service RAB assignment information, if the forced queue
switch is opened, then this CS 64kbps service has the queue ability.
If RAB assignment message or SRNC relocation request does not carry queue information
or indicate the RAB does not have queue ability. Operator can open the switch to improve
the KPI.

7.1.1.15

Maximum Time in the True Queue when Service be Forced into Queue


OMCR

Path ： View->Configuration

Management->RNC NE->RNC Radio Resource

Management-> Advanced Parameter Manager->Global Access Control->Maximum
Time in the True Queue when Service be Forced into Queue
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Parameter configuration

This parameter indicates the maximum time in the true queue when service is
forced into queue. The default value is 6s, value scale is 0~60s. This parameter
value should be smaller than or equate to the timer duration of the RAB response
of CN.
Decreasing this parameter will shorten the maximum queuing time of a call be
forced in the true queue, making it more likely to fall out of the queue.
Increasing this parameter will increase the maximum queuing time of a call be forced in the
true queue, making it difficult to fall out of the queue.

8

Counter And Alarm

8.1

Counter List
Counter No.

Description

C310504764

Number of rejected services, DCH uplink user limit

C310504765

Number of rejected services, DCH uplink_RTWP limit

C310504766

Number of rejected services, DCH uplink CREDIT_LIMIT

C310504767

Number of rejected services, DCH uplink OVERLOAD

C310504768

Number of rejected services, DCH downlink USER limit

C310504769

Number of rejected services, DCH downlink TCP limit

C310504770

Number of rejected services, DCH downlink CREDIT limit

C310504771

Number of rejected services, DCH downlink OVERLOAD

C310504772

Number of rejected services, DCH no code

C310504774

Number of rejected services, HS user limit

C310504775

Number of rejected services, HS cell total pwr limit

C310504776

Number of rejected services, HS traffic volume limit

C310504778

Number of rejected services, HS total power limit

C310504785

Number of rejected services,HSDPA conversation class services

C310504786

Number of rejected services, HSDPA Interactive class services

C310504787

Number of rejected services, HSDPA Background class services

C310504788

Number of rejected services, HSDPA Streaming class services

C310504793

Number of rejected services,HSUPA conversation class services

C310504794

Number of rejected services,HSUPA Interactive class services

C310504795

Number of rejected services,HSUPA Background class services

C310504796

Number of rejected services,HSUPA Streaming class services

C310504801

Number of rejected services, Setup
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C310504802

Number of rejected services, Handover

C310504803

Number of rejected services, DRBC

C310504804

Number of rejected services, non-DRBC Reconfig

C310494628

Number of Resource requisition attempt

C310494629

Number of Resource requisition failure

C310271696

Number of RNC initiate release by Rab Release Request for CSspeech by RAB pre-empty

C310271715

Number of RAB release by Iu release request for CS-speech by RAB
pre-empty

C310271729

Number of RAB release by RAB release request for CS by RAB preempty

C310271748

Number of RNC initiate RAB release by Iu release request for CS by
RAB pre-empty

C310271767

Number of RNC initiate RAB release by for CS-Speech by RAB preempty

C310271786

Number of RNC initiate RAB release by for CS-Videophone by RAB
pre-empty

C310275904

Number of RNC initiate RAB release by release request for CSHSDPA by RAB pre-empty

C310275923

Number of RNC initiate RAB release by release request for CSHSUPA by RAB pre-empty

C310281800

Number of RAB release by RAB release request for PS by RAB preempty

C310281819

Number of RNC initiate RAB release by Iu release request for PS by
RAB pre-empty

C310281833

Number of RNC initiate RAB release by RAB release request for PS HSDPA by RAB pre-empty

C310281852

Number of RNC initiate RAB release by Iu release request for PSHSDPA by RAB pre-empty

C310281866

Number of RNC initiate RAB release by RAB release request for PS HSUPA by RAB pre-empty

C310281885

Number of RNC initiate RAB release by Iu release request for PSHSUPA by RAB pre-empty

C310281904

Number of RNC initiate RAB release by release request for PSHSDPA by RAB pre-empty

C310281923

Number of RNC initiate RAB release by release request for PSHSUPA by RAB pre-empty

C311774805

Number of PS Downgrade due to UL CE Congestion

C311774806

Number of PS Downgrade due to DL CE Congestion

C311774807

Number of PS Downgrade due to Code Congestion

C311774808

Number of PS Downgrade due to UL Power Congestion

C311774809

Number of PS Downgrade due to DL Power Congestion
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8.2

C310200611

Total queue time of SPEECH RAB assignment setup

C310200612

Total queue time of CS64 RAB assignment setup

C310200613

Total queue time of Streaming class RAB assignment setup

C310200614

Total queue time of Interactive class RAB assignment setup

C310200615

Total queue time of Background class RAB assignment setup

C310200616

Number of queue SPEECH RAB assignment setup

C310200617

Number of queue CS64 RAB assignment setup

C310200618

Number of queue Streaming class RAB assignment setup

C310200619

Number of queue Interactive class RAB assignment setup

C310200620

Number of queue Background class RAB assignment setup

C310100890

Total number of successful Multi RAB assignment setup with queuing

C310110542

Total number of failed Multi RAB assignment setup with queuing

C310383642

Failed RAB modification number with queuing for CS
domain,TQUEUING Expiry

C310383789

Failed RAB modification number with queuing for PS
domain,TQUEUING Expiry

C310110329

Number of failed RAB assignment setup in cell for CS
domain,TQUEUING Expiry

C310110386

Number of failed RAB assignment setup in cell for PS
domain,TQUEUING Expiry

C310175765

Number of failed HSDPA RAB assignment setup in cell for CS
domain,TQUEUING Expiry

C310175810

Number of failed HSUPA RAB assignment setup in cell for CS
domain,TQUEUING Expiry

C310170625

Number of failed HSDPA RAB assignment setup in cell for PS
domain,TQUEUING Expiry

C310170670

Number of failed HSUPA RAB assignment setup in cell for PS
domain,TQUEUING Expiry

Alarm List
This feature has no related alarm.

9

Glossary
A
ARP

Allocation/Retention Priority

D
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DRBC

Dynamic Radio Bearer Control

G
GBR

Guarantee bit rate

M
MBMS

Multimedia Broadcast Multicast Service

N
NRT

Non-real Time Traffic

R
RT

Real Time Traffic

RTWP

Received Total Wide Band Power

T
TCP
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